Model ST360 Radiation Counter

The ST360 Radiation Counter combines many features into a single inexpensive instrument. The classic
nuclear scaler design has been expanded to include a preset time function, a digital rate-meter with alarm,
a digitally controlled high voltage supply, and computer interfacing via RS232 serial or USB formats.

The ST360 includes BNC and MHYV connectors, and a precision high voltage supply that is adjustable
from O to +1200 volts. This supply provides 0.5mA at 1200 volts making it suitable for many types of GM
tubes and scintillation detectors.

The preset time function enables the user to acquire radioactive events for a predetermined number of
seconds. This is necessary for accurately comparing radioactive sources.

The rate-meter function is ideal for contamination survey work and instantaneously displays the counts-
per-second. A programmable audio alarm is included and sounds once the count rate exceeds the set
level, warning of a possible high activity condition.

Extra large LED's provide a digital display that is clear and visible, even under bright ambient light. A 5-
segment bargraph LED visually indicates the activity level and speaker volume.

Classroom demonstrations and nuclear experiments can be run directly from an IBM-PC compatible
computer running Microsoft Windows using either a serial or USB interface. The provided software
renders all of the ST360’s controls accessible from the PC and allows real-time data transfer to the
computer. This data can be stored in spreadsheet compatible files allowing data analysis and graphical
presentation using many common spreadsheet programs.

The software includes one mode that recycles counting after reaching a preset time and another mode
that automatically increments the high voltage after each cycle. The first mode is useful for performing
radioactive decay studies while the latter is useful for plotting detector plateaus.
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Specifications

Inputs: BNC connector - Accepts standard Geiger tubes.
MHV connector - Accepts scintillation detectors.

High voltage: 0 to +1200 volts @ 0.5mA, selectable in 20 volt increments.
Display: 6-decade LED, 1 in. numerals; 5-segment bargraph LEDs

Modes: Counts; Elapsed Time; Preset Time; Count Rate (counts per second); High Voltage Level;
Alarm Level; Speaker Volume.

Audio: Audio Alarm set by Alarm Level; Audio indication of radiation events
Interface: USB and RS-232 serial ports for both PC and Macintosh
Power: 9 volt DC, at 500mA*

Dimensions: 10in.W, x7in.D,x4.5in.H

Software: LABLINK software for DOS, Windows and Macintosh on CD

Caution: Use only the AC adapter included with the ST360. Using a different adapter can
damage the unit and void the warranty.




Controls

Below is a brief description of the ST360’s controls. A detailed explanation of the controls is in the
Operating Modes section.

COUNT Control

The COUNT button starts the timer and event data acquisition. The corresponding LED indicates
when the unit is counting.

STOP Control

The STOP button stops the timer and event data acquisition. The corresponding LED indicates when
the unit has stopped counting.

RESET Control
Pressing the RESET button when counting is stopped resets the time and counts to zero.

DISPLAY SELECT Control.

Pressing DISPLAY SELECT cycles through each mode in the following order: COUNTS, TIME, RATE,
HIGH VOLTAGE, ALARM POINT, SPEAKER VOLUME, then back to COUNTS, etc... On the right
side of the display, a corresponding LED will indicate the selected mode unless the unit is in
SPEAKER VOLUME mode. In SPEAKER VOLUME mode there is no indication LED.

DOWN and Up Controls

The DOWN and UP buttons are used for setting the preset time, high voltage, alarm point and
speaker volume.



Operating Modes

Below is a description of each mode. As described above, the DISPLAY SELECT button cycles through
the modes. Modes can change at any time, even if the unit is counting, without affecting the data or
interrupting the count.

COUNTS Mode.

The COUNT mode is for displaying the number of radioactive events, or counts. During data
acquisition, the display will increment in real time.

TIME Mode

The TIME mode is for either displaying the elapsed acquisition time or for setting the Preset Time.
When selected, the TIME mode display shows the elapsed time of the most recent data acquisition. If
DOWN or UP is pressed, the view will switch to Preset Time.

The Preset Time function will allow the user to automatically count radiation events for a
predetermined amount of time. To engage the Preset Time function, select the TIME mode and enter
the preset time value using the UP/DOWN buttons. Pressing the COUNT button will cause radioactive
events to accumulate for the preset time value. Afterwards, counting will automatically stop. Pressing
COUNT a second time will reset the counts and elapsed time to zero, and again accumulate events
until reaching the preset time value. Counting can be interrupted using the STOP button, without
losing current data or the time elapsed. Pressing COUNT again will continue data acquisition for the
remaining preset time. To stop the Preset Time function, set the preset time to zero.

RATE Mode

This mode provides an instantaneous display of the count rate in counts-per-second. It can be very
useful for survey applications, particularly when used in conjunction with the ALARM feature.

The ACTIVITY bargraph on the left side of the display will also indicate the count rate when the unit is
counting. Each segment of this bargraph represents an additional count rate of 200 counts-per-
second. That is, one segment lights between 200 and 400cps, two segments between 400 and
600cps, three segments between 600 and 800cps, four segments between 800 and 1000cps, and five
segments between 1000 and 1200cps. This bargraph is active in every mode except speaker volume
mode.

HIGH VOLTAGE Mode

This mode is for either displaying, or setting the high voltage level. The high voltage can be set to any
value between 0 and 1200 volts in 20-volt increments using the UP/DOWN buttons. The COUNT,
STOP, or RESET buttons do not affect the high voltage setting.

ALARM POINT Mode.

This mode is for setting a number that, if exceeded by the count rate, causes an alarm to sound. To
set the alarm point number, select this mode and use the UP/DOWN buttons. The COUNT, STOP, or
RESET buttons do not affect the alarm point setting.

SPEAKER VOLUME Mode

This mode is for displaying or setting the speaker volume and has no associated LED indication. The
UP/DOWN buttons set the speaker volume. When in this mode, the bargraph activity LED becomes

a speaker volume indicator.



ST360 Software Installation and Operation
Microsoft Windows Version

Introduction

The supplied software provides full control of the ST360 from an IBM compatible PC or Macintosh
computer. It allows the user to save data to the PC and to use the features described in the Operation
section below. The latest software revisions are available on our web site at
www.spectrumtechniques.com.

Installation

Place the installation CD into the CD-ROM drive and the software installer program will display the
following menu:

Note: If the menu does not appear, run the file named Setup.exe directly from the CD ROM'’s root
directory. For Macintosh installation, manually copy the LABLINK 360 Macintosh folder to the hard drive.

& Software Installer Ver. 1.01
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Select ST360 and follow the prompts to install the ST360 operating software. If using a serial interface,
proceed to the Serial Interface section and then to the software section. If using a USB interface, then skip
over to the USB Interface section.

Serial Interface

The ST360 includes an RS232 connecter for interfacing to the PC via the serial port. To use this
interface, connect the serial cable from the PC’s serial port to the ST360 connector labeled RS-232
PC. This connector is located on the ST360’s rear panel.



Run the ST360 software by double-clicking on the desktop icon. If the correct COM port is selected
(software defaults to COM1), then everything should function normally. However, if the incorrect COM
port is selected, a message box will appear stating "Unable to communicate with instrument". If this
happens, try a different COM port by selecting Communications under the Setup menu. This will open
a text box entitled Instrument/Com Setup, which allows the COM port to be changed.

Inztrument/Comm Setup

Communication

Serial Port: | COM1 =l

Cancel | Help |

After switching COM ports, click on ReSync under the Setup menu to re-establish communication. If
communication will still not re-establish, check for an improperly connected or defective serial cable.

USB Interface

When using the USB interface, leave the installation CD in the CD-ROM drive. Connect the PC’'s USB
connecter to the ST360 connector labeled USB. Turn the ST360 ON and the Add New Hardware
Wizard will appear.
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Select Next. The Wizard will proceed to the next display.
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Select Search for the best driver for your device, and Next. The Wizard will proceed to the next
display.
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Select CD-ROM drive and Specify a location. Verify that the text box is displaying the correct path to the
CD-ROM drive and select Next. (NOTE: In this example the CD-ROM drive is shown as "E". However, it
may be a different letter depending on the configuration of the user’'s PC). The following display will
appear when Windows has found the correct driver on the installation CD.
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Select Next. The Wizard will proceed to the next display, indicating that driver installation is complete.

Add Hew Hardware Wizard |

% Spectum Technigues - ST3E0

YWindows has finizhed inztaling the software that your new
hardware device requires.

< Back

Select Finish to end installation. Run the ST360 software by double-clicking on the desktop icon.



Operation

When the ST360 program opens, it defaults to the Scaler view, with the title bar reading ST360 USB - -
[Data Window] or ST360 Serial - -[Data Window].
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In the upper part of the main display are the menu headings. From left to right, they are: File, Edit, Setup,
View, Preset, Instrument Display, Window, and Help. Menu selection is either by using the mouse or by
holding the Alt key and pressing the key corresponding to the underlined letter in the title’s name.

Below the menu titles are icons for running commands. From left to right, they are File Open, File Save,
Print, Start, Stop, and Erase.

Under the icon row are sections displaying various data and settings. The sections include Counts, Data,
Preset Time, Elapsed Time, Runs Remaining, and High Voltage.

Note:
When connected to a PC with the software running, the ST360's controls will NOT function,
allowing it to only be controlled from the PC. Once the user has exited the ST360 program or
the COM port is disconnected, the user will regain use of the ST360’s controls.



Menus

This section describes the menus and their contents. The menus are File, Edit, Setup, View, Preset,
Instrument Display, Windows, and Help.

File

The File menu contains Open, Save, Save As, Print, Print Setup, and Exit.

flsT3s0UsSE - -

File Edit 5Setup “iew Preset Insh

Iﬁ:gpen... Ctrl+0 o7
E Save Chrl+5 J_l

Save bs...

Frint ...
Print Setup ..

Exit

Open

Open allows the user to open a previously saved file with the .sdf extension and display it in the Data
section of the main display. Once a file has been opened, any additional data acquired will
automatically append itself to the end of the list.

Save / Save As

Save allows the user to save the current data displayed in the Data Section. If the data has been
previously saved, it will be saved with the same file name. If the data has not been previously saved, it
will prompt the user for a file name and allow selection of a different directory. Save As always ask for
a file name, whether or not the file has been previously saved. The file is always saved in 2 formats,
.sdf and .tsv. The .sdf version can only be opened by the ST360 program. The .tsv version can be
opened in database spreadsheets such as Microsoft Excel.

Print / Print Setup

Print opens the standard Windows printer dialog box allowing the user to select the printer properties,
printing range, and the number of copies. Selecting OK will print the description, number of runs,
preset time, pause time, alarm level, high voltage setting, counts, date, and time. Print Setup will open
the standard Windows dialog box, allowing printer configuration.

Exit
Selecting Exit will close the program.

Edit

The Edit menu contains the Copy selection.
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Copy

Copy is the only selection in the Edit menu. It allows the user to copy the description, number of runs,
preset time, pause time, alarm level, high voltage setting, counts, date, and time to the Windows
clipboard. Afterwards, the user can paste the data into another application.

Setup

The Setup menu contains Description, HV Setting, Set Volume, Communications, and ReSync.
Communications and ReSync are only available when communication is established via the serial port.
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Description

Description opens a text box that allows the user to enter a description of the data. This description is
included when the data is printed or copied as described above. When entering text into the
Description box, it will scroll to the left once the text size exceeds the visible area.

Description

Caricel |

HV Setting

The HV Setting opens the following box, which allows the High Voltage and Step Voltage to be set in 5-
volt increments. The High Voltage setting is the actual voltage applied to the detector. Use the Step
Voltage Enable selection in conjunction with Preset Time and Runs to automatically increment the high
voltage each time a run is executed. The Step Voltage is the amount that the High Voltage is incremented
with each run. This feature is useful for obtaining plateau charts and is further explained in the section,
Creating a Plateau Chart.
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The High Voltage and Step Voltage values are displayed in the lower right corner of the main display.
If the Step Voltage Enable is set to OFF, only the High Voltage will be displayed.

Set Volume

Set Volume opens a box that displays all the possible volume settings, along with the current setting.

The settings range from 0 to 5, 0 being OFF and 5 being the loudest. To change the setting, select a
number and click OK.
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Communications

Communications opens the following box, allowing the user to select COM ports. Once the port is
selected, click OK to close the box.
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ReSync
If communication to is lost between the ST360 and the PC, click on ReSync to re-establish it.

View
The View menu contains the three main views of the ST360: Scaler, Digital Rate Meter, and Analog Rate
Meter.
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Scaler
When the ST360 program first runs, it defaults to the Scaler view.

Digital Rate Meter

The Digital Rate Meter view displays the counts in counts-per-second or in counts-per-minute. The
counts-per-second view is identical to the ST360’s display when it is in Rate mode. The counts-per-
minute display is only available using the ST360 software.

Analog Rate Meter

The Analog Rate Meter view simulates an analog meter by displaying a meter and a moving needle.
Users accustom to analog meters will find this view helpful. The meter is also auto-ranging and
automatically sets it's self to the correct scale, regardless of the count rate. As with the Digital Rate
Meter view, the Analog Rate Meter view displays the count rate in counts-per-second or in counts-per-
minute.

The figure below shows all three views displayed simultaneously.
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Preset
The Preset menu allows certain parameters to be set before counting takes place.
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Alarm Level

Alarm Level opens a box that displays the available alarm settings in counts-per-second. The setting
range is from 0 to 3000, with 0 being OFF. To change the setting, select a number and click OK. When
the count rate exceeds the setting, the alarm will sound.
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Current Setting:

Preset Time

Preset Time opens a box that displays the available preset time settings in seconds. The setting range
is from O to 900,000, with 0 being OFF. To change the setting, select a number and click OK. When
the preset count setting is reached, the counting will stop.
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The Preset Time is always visible in the upper right-hand corner of the main window.

Preset Time:

Pause Time

Pause Time is used in conjunction with Preset Time and Runs. It causes the counting to pause for a
predetermined number of seconds between runs. When Pause Time is selected, the following box
appears. Enter the time in seconds.
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Runs
When Runs is selected, the following box appears.

Set Number of Runs |

Furs: |2

Cancel | Help |

Enter the number of runs and click OK. When used in conjunction with Preset Time, this feature
causes counting to automatically repeat after the unit counts for the preset time. If the Step Voltage is
set, the high voltage will increment that amount each time a run is executed. Once all the runs have
been executed, the counting will stop. During this operation, the Runs Remaining section of the main
view displays the remaining runs.

Runs Remaining:

Instrument Display

The Instrument Display menu allows the user to change the ST360’s display from the PC. The ST360's
display will show Counts, Elapsed Time, Counts per Second, High Voltage, and Rate Alarm Setting by
selecting it from the pull-down list.
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Window

When displaying the analog and digital rate meters, along with the main view, the Window menu provides
choices for arranging these displays within the program’s main window. The windows may be cascaded,
tiled horizontally, tiled vertically, minimized, etc...
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Help

The Help menu provides immediate help for the user. To utilize the help feature, select Help and the topic
you wish to view.

Command Icons
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File Open, File Save, and File Print

The first group of icons from the left is the File Open, File Save, and the File Print icons.
The File Open icon functions exactly like the Open command in the File menu.
The File Save icon functions exactly like the Save command in the File menu.

The File Print icon functions exactly like the Print command in the File menu.

Count, Stop, and Erase
The second group of icons consists of the Count, Stop, and Erase icons.

The Count icon functions exactly like the COUNT button on the ST360.
The Stop icon functions exactly like the STOP button on the ST360.

The Erase icon erases all the data in the data section. However, as a safety precaution it will prompt
the user to save the current data before deleting it.

Note: If any of the icons are grayed out, it means they are not available at that particular time. In
the example below, the File Save, File Print, and Stop icons are grayed out. This is because
the Data section contains no data to save or print, and the ST360 is already in STOP mode.
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Information Display Sections:

As the illustration below shows, the main display has 7 sections for displaying information: Counts, Data,
Preset Time, Elapsed Time, Runs Remaining, HV, and Step.
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Counts Section

The Counts section displays the total number of counts. It functions exactly like the ST360 display in
COUNTS mode.

Data Section

The Data section displays information for each data acquisition. This information includes Run, HV (high
voltage setting), Counts, Elapsed (time in seconds), Date, and Time. This is the actual data that is stored
when using the Save command.

Preset Time Section
The Preset Time section displays the current Preset Time setting.

Elapsed Time Section

The Elapsed Time section displays the time elapsed during counting. The elapsed time will reset to 0
when either the data is erased or when counting is re-started after the end of a preset time. If the preset
time is not set, or counting is interrupted with the Stop command, the elapsed time will not reset and will
continue running when Count is selected again.

Runs Section
The Runs Remaining section displays the remaining number of runs set by the Runs setting.

HV Section

The HV section displays the current high voltage setting.



Step Section

The Step window displays the high voltage step size and is only visible when the step voltage is set.



System Operation

Basic GM Tube Setup and Operation

Warning!
Dangerous voltages can exist at the GM and SCINT connectors. Ensure that the high voltage is
set to zero or that the instrument is OFF before connecting or disconnecting a detector.

Caution:
Simultaneously connecting a GM tube and a scintillation detector to the ST360 will result in
erroneous data. Only connect one at a time.

1. Connect the ST360 to its AC adapter.
Connect a GM tube to the GM connector via a BNC cable.

3. Enter the HIGH VOLTAGE mode and set the high voltage to the recommended value for the GM
tube.

4. Place the radioactive source close to the GM tube’s window.

Using the Operating Mode information described above, set the unit up to perform the desired
function.

6. Press the COUNT button to start data acquisition, the STOP button to halt data acquisition (providing
Preset Time is not being used), and the RESET button to reset the time and data to zero.

GM Tubes

Geiger-Mueller tubes produce electrical pulses when ionizing radiation events occur within their sensitive
volume. For proper operation, only run these detectors at the manufacturer's specified voltage. If this
voltage is not known, then it must be derived empirically by plotting a plateau (see below). To improve
sensitivity to alpha and beta particle radiation, many GM tubes have extremely thin entrance windows,
which require considerable care in handling. Do not remove protective caps unless necessary and never
touch the window.

GM Tube Plateau

The correct operating voltage for the Geiger-Mueller tube may be determined experimentally using a
radioactive source such as Cs-137 or Co-60. A properly functioning tube will exhibit a "plateau” effect,
where the counting rate remains nearly constant while the high voltage is increasing linearly. A plateau
chart is obtained by using a constant preset time to count a source for several runs, while increasing the
high voltage by some constant amount after each run. This process is described in detail in the next
section, Creating a Plateau Chart.



Creating a Plateau Chart

Running the unit as stand-alone
1. Place the radioactive source in a fixed position close to the window or in the well of the detector.

2. Putthe ST360 into Count mode and slowly increase the high voltage until the first bar of the
ACTIVITY bargraph lights.

Set the Preset Time to 10 seconds and press COUNT.
When the preset time expires, record the counts and the high voltage setting.
Increase the voltage by 20 volts and count data again.

When the preset time expires, record the counts and the high voltage setting again.
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Repeat steps 5 and 6 until the high voltage reaches its upper limit (this is determined by the upper
operating voltage limit of the detector).

8. Create an X-Y graph of the data, with “Y” being the Counts, and “X” being the voltage, and plot the
chart.

Using the ST360 Software

1. Place the radioactive source in a fixed position close to the window or in the well of the detector.

2. Put the unitin COUNT mode and slowly increase the high voltage until the first segment of the
activity bargraph lights. This is the starting voltage.

Determine the upper operating voltage limit of the detector. This is the ending voltage.

3. Subtract the starting voltage from the ending voltage. Divide the result by the high voltage step
size (20 volts in this case). This will yield the number of runs.

4. Select High Voltage Setting in the Setup menu and set the High Voltage to the starting voltage
and the Step Voltage to 20. Also, turn the Step Voltage Enable ON.

Select Preset Time in the Preset menu and set it to 10 seconds.
Select Runs in the Preset menu and set it to the number calculated in step 3.

After counting has begun, it will automatically stop when runs equals zero.
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Save the data to a file. Before saving, a description of the data may be entered into the
Description box.

9. Open the saved file version with a .tsv extension into a spreadsheet program such as Microsoft
Excel.

The following illustration shows a typical detector plateau.
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Natice that the counts form a relatively flat place on the graph between 850 and 1100 volts. The center of
this area, at approximately 1000 volts, is the recommended operating voltage for the detector. However,
any voltage in this flat region would be acceptable. Also, notice that the counts increase rapidly as the high
voltage nears its upper limit. This indicates that the tube is entering its breakdown region. Do not continue
to operate the tube in this region.

Resolving Time

Geiger-Mueller tubes exhibit dead time effects due to the recombination time of internal gas ions after an
ionizing event occurs. The actual dead time depends on several factors including the active volume and
shape of the detector. Dead time can range from a few microseconds for miniature tubes, to over 1000
microseconds for large volume devices.

When making absolute measurements it is important to compensate for dead time losses at higher
counting rates. If the resolving time of the detector is known, the true counting rate may be calculated from
the measured rate using the following expression:

n=m/1-mt
where n is the true counting rate, m the measured rate, and t the detector resolving time.

If the detector resolving time is unknown, it may be determined experimentally using two radioactive
sources. Maintaining constant counting geometry is important throughout the experiment. A special
source split into two halves (Spectrum Techniques part # RSS-2) is available for making the
measurement, but good results may be obtained by careful positioning of two standard check sources.
Perform the following steps to calculate the resolving time:

1. Setthe ST360 to Rate mode.

2. Position the two sources (a+b) side by side and close enough to the GM tube’s window to obtain a
count rate of at least 10,000 CPM.

3. Record the count rate as Rasp).

4. Remove source (b) and record the count rate as R,.

Carefully replace source (b) to its original position, remove source (a) and record the count rate of
source (b) as R,).

Solve for the resolving time using this equation T= R(arRp)-Ra+b)

2R@-Rp)

The resolving time of the ST360 RADIATION COUNTER is very short and is not a significant factor
compared to that of the GM tube.



The Wipe Test System

The ST360 Radiation Counter will also operate with Nal(Tl) scintillation tubes for detecting low-level
gamma and X-ray emission from a variety of samples. The Wipe-Test system includes a well detector,
base, cable, and lead shield for measuring wipes or tube samples.

This system will detect gamma and X-rays ranging in energy from 20 keV to several meV. Each system is
factory calibrated and should not require further adjustment unless a different detector or base is used. A
Cs-137 calibration source is included for routine checking of overall system performance and quality
assurance. Details of the Wipe Test system setup, operation, and calibration are covered in the following
sections.

The Wipe Test

The Wipe Test system should be set up in the following manner:

1. Install the scintillation detector into socket in the base of the stand. Note that the base of the
detector is keyed and will only locate in one position of the socket.

2. Place the lead shield over the top of the detector allowing it to rest on the vertical metal support
tube.

3. Insert the plastic liner into the well.

Caution:
This liner provides protection from mechanical damage and contamination. The aluminum wall
inside the well is very thin and can be damaged if a tube is inadvertently dropped into the well

without the liner in place.

1. Connect the coaxial cable from the detector assembly to the input labeled SCINT on the rear of
the ST360.

2. Turn the ST360 ON. Using either the ST360 program or the front panel controls set the high
voltage to the value marked on the detector assembly.

3. Set the Preset Time to the desired number of seconds and begin counting.

Checking the System Calibration

Use the supplied calibrated Cs-137 source to check the counting efficiency and overall system
performance. This source has its activity marked in counts per minute (cpm) and the date of manufacture.
Over time, the source decays with a half-life of 30.1 years and it will be necessary to periodically correct
the activity.

1. Place the calibrated Cs-137 source into the plastic well-liner and into the well of the detector.
2. Setthe Preset Time to 60 seconds and begin counting

3. After counting is finished, the reading should correspond within £10% of the activity in cpm
recorded on the source. For better accuracy, use the average of three separate readings.

Taking a Background Reading

Wipe tests are inherently low-level measurements and it is necessary to perform background subtraction
on all samples to generate accurate activity data. Because the background reading is low, it should be
counted for a longer period to improve the statistics.

1. Remove all radioactive material from the vicinity of the detector.

2. Set a preset time of 600 seconds and begin counting.

3. When counting is complete, record the value and divide it by 10 to derive the background counts-
per-minute.



Measuring Wipes
Using the well-liner, position the sample into the well of the detector.
Set the preset time to 60 seconds and begin counting.

When counting is complete, record the count.

A w Db P

Subtract the background counts-per-minute and record the value. This is the correct
counts/minute for the sample.

System Re-calibration

The system is calibrated at the factory, and under normal circumstances, recalibration should not be
required. However, in the event of a detector or detector base replacement, it will be necessary to
determine the correct operating voltage for the system. Using the Cs-137 source supplied with the system,
refer to the section Creating a Plateau Chart to obtain the correct operating voltage
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Warranty and Repair Information

Spectrum Techniques warrants products of our manufacture against defects in workmanship or material
for a period of one year from date of shipment. We will repair or replace, at our option, any instrument that
is deemed defective during this time. This warranty covers all replacement parts and labor. The instrument
must be returned to our factory prepaid and we in turn will pay the cost of the return shipping.

The warranty does not cover damage caused by mishandling or misuse. GM tubes with broken windows
are specifically excluded from this warranty. Accessory items not manufactured by Spectrum Techniques
but supplied as part of our systems will be subject to the original manufacturer’'s warranty.

For warranty-repair information or return authorization, contact customer service at:

Spectrum Techniques
106 Union Valley Road
Oak Ridge, TN 37830
Tel: (865) 482-9937
Fax: (865) 483-0473
www.spectrumtechnigues.com
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